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Speaker 1: This is the Beginner's Guide to using Microsoft Word, and specifically using it to create documents like reports, essays, handouts, flyers, things like that. So I'm just going to go down here and click on Microsoft Word. If you don't have Word down here on the taskbar, you can just click here on search windows and do a search for Microsoft Word to see if it's on your computer. If that doesn't turn up anything, then it's not installed on your computer. But like I said, I'm going to go ahead and click on that to start it up, and Microsoft Word opens right up, and it gives me right away a bunch of templates that I can choose from to help me get started creating documents using Microsoft Word. You can see that there's all sorts of great documents. They have trifold brochures, they have event menus, they have blog posts, all sorts of different templates that you can use. Also across the top, notice that you can filter them by category. So I could just show business templates, I could show event templates, labels, and so on. Notice that there is an education category. You can also search for online templates here. So templates can be a great time saver. You can just select one of these templates to open it up and then edit it and use it for your own purposes. But in this tutorial, we're going to focus just on creating starting from scratch. So I'm going to click here where it says blank document, and it opens up the Microsoft Word layout and a blank document. Now, there is so much to Word. Most people don't really use Word to its full capabilities. But in this tutorial, I'm really going to focus on the basics, on those essentials that you need to know to start using Microsoft Word effectively. One of the first things I'm going to do is just close this panel here at the left that says navigation. It's a nice panel, but I'm going to get rid of that and close that out. Next, I want to give you a quick tour of what you're seeing here in the layout. You'll notice that across the top, we have tabs. We have the Home tab, Insert tab, Design tab, and this is very similar to Excel, Microsoft Excel, and also Microsoft PowerPoint. If you've watched my other tutorials, you already know about this Microsoft Office layout. But for those who maybe haven't watched those other tutorials, just a quick intro. Each of these tabs, when you click on it, will give you a different ribbon, and that's what they call this. This is the ribbon, and the ribbon changes based on the tab that you click. Okay, so if I want to change something about the layout, I click on layout, and then I look at the layout ribbon and see what I can do. Now, each ribbon is divided up into groups. So this is the Page Setup group, this is the Paragraph group, and the Arrange group. Now, what if I want to insert something, maybe a picture or a photo? I would go to the Insert tab and click, and I get the Insert ribbon with lots and lots of different groups. Now, one thing about groups that you need to be aware of is some groups will have a little launch button in the corner. So here's an example of a launch button. The Paragraph group has a launch button, but the Arrange group doesn't, at least for me it doesn't. The Page Setup group has a launch button. So what are these launch buttons, and why do you need to know about them? Well, basically, whenever you see a launch button, what that means is that there are more tools, but that they couldn't fit them in the space provided in the group. So if I don't see one of the font options that I would like to have, I look through these to see if it's there, and if it's not, I can just click here on the launch button, and then I'll get even more options. Another example over here in the Styles group, there's a few styles, but if I click here, then I get many, many more styles to choose from, and some options that I don't see just by looking at the group itself. So watch out for that launch button. Okay, now down here, I have the page of my document. This is my Word document, and it's completely blank at this time. A couple of things that I want you to know about before you get started making a document. First of all, I don't know about you, but I like to be able to see the document, at least its width. And so I'm going to go down here in the lower right corner and change the zoom level. So it was at 200%, and that was a little bit too big for me. Maybe 150, maybe 125, you know, something like that, that will be a little bit easier to fit on the screen. So I think I'll just go with this, 100%. Now in this tutorial, I'm using Microsoft Word 2016 for Windows. But if you're using an older version of Microsoft Word, or even a future version of Microsoft Word, or Word for Mac, most of what I'm showing you will still be applicable. But one of the things that I kind of miss from an older version of Microsoft Word is I miss the rulers. I'm used to having a ruler across the top, and also down the left side to help me know the size of the page that I'm working with. So I'm going to go here and look and see where might there be an option to show the ruler. And I would think it would be maybe here in the layout options. But the reason I'm bringing this up is because if you're having trouble finding an option, like I am right now, you don't need to really hunt and search for it very much. If it's not quickly showing up, all you need to do is go here to the top where it says, tell me what you want to do, and do a search. So I'll do a search for rulers. And look, right there at the top, there's an option that says show ruler, and I can click on it, and immediately the rulers pop up. Okay, so I'm happy now with the look of Microsoft Word. Okay, now I'm ready to start creating a wonderful document. And let's say this document is going to be a handout or a worksheet for my students. I can just go in and start creating. So I'll just provide a space there for the name of the student, the class period, and I'm just typing and hitting return or enter on the keyboard. And I would like this to be the title of my document. Now, this is pretty typical, but what I would do here is highlight the text, and immediately I get a pop-up here with some options that I have, but I can also go here to the home tab, home ribbon. That's where you'll find the most commonly needed options in Microsoft Word. And so look, there is center, and that's what I was hoping for. I can also underline if I want to, I can make it bold, and there's all sorts of options that you have there. I could make the text bigger, but more often than not, instead of making all of these fine-tuned adjustments, what I often do is I use these styles. And so to show that, I'm gonna click the undo button several times to go back to just the text. So with just the text selected, I'm gonna go here where it says styles, and I'll go to heading number one. And you can see what it does. It changes the color, it makes it bigger, changes the font a little bit. There's also heading number two and several other options. Title would be a good one as well. And I'm gonna go with title. Now, regardless of which one you pick, if you want, you can still adjust it. Like I would still like that to be centered. I would still like it to be underlined. And I think that looks really nice. So now I hit enter or return, and I can proceed to create this worksheet. I can type in instructions for my students. And Microsoft Word handles most of the work. I'm just typing, hitting enter, moving down. Now, I can also click to move around using the mouse, but watch what happens. I can only click so far. It's not letting me go past the current line that I've typed. I can go to the right side of it, but that's as far as it'll let me go. I can go back up, though, by clicking and make changes, make adjustments. Okay, and I'm really ruining this document, aren't I? So I'll just undo a few times. But the point is that if you want to put in some blank space and then type something below, you're gonna have to tap enter a few times to move the cursor down, and then you'll be able to type down below. Now, when you get to the bottom of the page, you hit enter, and look, it just takes you automatically to page number two. Now, a few other essential things to know about Microsoft Word include how to insert pictures, because that's really one of the powerful things about Microsoft Word. And you heard me say the keyword there, didn't you? It's insert. So I click on insert and look at the options that I have for things to insert into this document, all sorts of things, including Wikipedia articles, online videos, all sorts of neat things. But in this case, I'm gonna go to pictures, and that automatically accessed my computer, and now I can browse my computer to find pictures that I can then pull in and use in my document. So I'll pull in this skeleton. Now, whenever you put a photo or an image into Microsoft Word, it brings up some difficulties. For example, that is not at all where I wanted that photo to be. I wanted it to be here in between the text up here and the text down below. And so this is a problem. The other problem is the photo came in way too big. So let's fix some of these issues. The first thing I'm gonna do is click on the picture. Now, something subtle just happened. When I clicked on that photo, look what happened. I got an additional tab and ribbon that appeared at the top of Microsoft Word. And this is gonna be very important. Anytime you click on something, especially something special like a photo or a video, it's gonna give you some extra options. In this case, the format options. First thing I wanna do though is just resize this image. So with it selected, I can just go to the corner, any corner, click and drag to shrink that photo down to size a little bit. And that's a lot better. Now, I still, I'm struggling. I'm trying to drag it up to the place I want it to be, but it's just not quite cooperating with me. The reason why is because this photo has some specific layout options that come pre-selected by default. And so I need to change those layout options. Now, in this latest version of Microsoft Word, when you click on a photo, you'll get this little button that pops up. You can then click on it to change the layout options. But just like in older versions of Microsoft Word, you also have the option to right click and go to wrap text and that will give you the same options. So here in wrap text, I'm gonna go with in front of text or behind text. Either one will work great. I guess I'll choose behind text. And now you can see what happened. Now it's moving much more freely. I was not able to do this before. I was not able to click and drag and put the picture wherever I wanted it to be. But just by changing the options to behind text or in front of text, now it's unlocked that photo and I can put it literally anywhere in this document that I want it to be. It could even be up here in the header or in the footer. It really doesn't matter. So that's a nice little trick that you'll want to know and be able to use in your own documents. I also want you to know that you can insert online pictures and this is a great option. You can connect to the internet and do searches and find images, find clip art and things that are on the web and then just click and drag to drop them into your project. So that's a really nice option to have. Now, before we move away from the photo and move on to other topics, I want you to notice this format tab that I mentioned earlier. When you click on a photo and then the format tab, it gives you some options to do some things that are really nice. You can remove the background. In this case, it wasn't very successful in how it removed the background. You can alter the color scheme in lots of ways. You can do some corrections and there's some artistic effects. And so there's some really pretty exciting things. You could come up with some creepy images here with this skeleton. I'm gonna undo that, but these photo effects are really pretty nice. You can compress the picture as well and do some other exciting things. There's also some picture styles. For example, you can put a frame around Mr. Skeleton here and there's all sorts of different frames. You can have a kind of a fuzzy border around the skeleton if you'd like. You can make it almost 3D with some of these 3D effects. So some really nice options. You can also crop and you'll be surprised how often this is helpful and necessary. So when I clicked on crop, it gave me some additional lines and edges and things like that. So I can use that to crop out part of the photo. Whoops. And I have to make sure I get the exact line there. And then I can just click outside the box and it makes that crop effective. So watch out for this format tab. It'll appear and give you some wonderful options that you need to be aware of. There are also all sorts of other great options, especially shapes are especially good. You can put in arrows. You can put in call outs. You can put in squares, rectangles, circles, plus signs, all sorts of great shapes that are useful, especially for teachers and students. And I want you to know that you can also add a text box. Now, how is a text box special? How is it different from the regular text that you're typing in? Basically a text box is additional text that can float on top of your document. So I'm gonna go with a simple text box and I'll type in a wonderful message here and then click away. This text box now can be dragged wherever I want it to go. Now it is interacting with that text. And if I don't want that to happen, I can use this button here to make it be behind the text, the other text, or in front of the text. I'm gonna go with behind. And so now I can drag it freely. So similarly to how I fixed this photo and made it so that I could drag it anywhere I wanted it to be, it's similar with text that's in a text box. Okay, now here in the review tab, a few other basics that you need to know about whenever you're writing a paper or a report or even a worksheet like this, it's important to get the spelling right. And you can see here on the review tab, you can click spelling and grammar and it will check for spelling mistakes. It looks like it found one. I don't know how I possibly misspelled this word, but I did. And if it can, Microsoft Word will suggest alternate spellings that are correct. In this case, I've got it stumped a little bit. So I'll close that out. But I just wanted to point that out. The spelling and grammar in Word is great and is really one of the basic essentials that you need to know if you're gonna be using Microsoft Word. There's also some great options like word count. If you're a student and the teacher has said, I want you to create a 2000 word essay or report, you can just click to get a word count and it'll tell you how many characters, how many words, how many pages, et cetera. There's also a wonderful thesaurus to help you use a variety of words instead of using the same word over and over. That's very helpful. Okay, so let's say you're done with your document and it's time to get ready to turn it in. If you're a student and you're finishing an assignment, let's say, or maybe you're a teacher and you've put together what you want to print and give to the students, how do you go from there? Well, one of the first things that you need to do is to consider if you have the right line spacing and things like that, especially for students. Maybe the teacher has said, I want you to double space your paper. How do you do that? Well, here on the Home tab, Home ribbon, you can go to Paragraph group and look right here. This is the line and paragraph spacing options. And you can go in and say, I want double spaced. Now, for that to really be effective, you need to click and drag to highlight the text that you want to affect. So now when I do line spacing, set it at two, now my paragraph has double spaced text. I also want you to notice that you have font color options and all sorts of typical font options that you're probably very accustomed to on all sorts of tools and on the internet. There's different fonts to choose from here as well. Okay, so I'm happy with this. I'm good. Of course, I could change the margins at the left and right using this ruler tool. But if I don't want to mess with that, I'll just leave it as is. Now, to finish this off, I just go to File and I have a bunch of different options. First, I really should save this and I can click Save. I can save it just to this PC and I could save it directly, let's say, to the desktop or to my documents. But also notice that there's an option to save it to OneDrive. And if you're not familiar with OneDrive, please watch my YouTube video on OneDrive. It's a wonderful tool, similar to Dropbox, but extra good for Microsoft Office and Microsoft Word in this case. Now, to access that, it would be helpful to sign in to your Microsoft account. And that way, like it says here, you can get to your documents from anywhere because you'll be signed in to your Microsoft Office account and basically OneDrive. In this case, though, I'll just save it to my desktop. It opens up and I just give it a name. So there's the name I want to use. I click Save and we're good to go. And of course, I can also click there on File and I could print it now that I've saved. I could've printed it without saving, but it's a good idea to save first just so you don't forget. But I can now print and there's all these print options. Now, in addition to print and save, notice what else that there is. There's export and this is very powerful. I could create a PDF out of this document. So I can click that, save it, also to the desktop in this case. And so now, when I go to my desktop, look, there is a PDF document that I've created from inside Microsoft Word. And here's the original in Word format. So that's a nice, powerful option just built right into Word. So I'm done. So I'm gonna close out of this document completely, go to my desktop. Let's say next week I need this same document. I can just go back to Word, open it up, and look, because it was recently created, it shows up here. So this is a list of recently created documents on this computer and there it is at the top. Now, as I use this more and more on this computer, I'm gonna end up with 20, 30, 50, 100 documents. It might be nice if this is a document that I'm gonna keep working on a lot over the next few weeks, it might be a good idea to try to get it to stay at the top of the list. Well, there is a way to do that. If you put your mouse on it, look, there's a little pin. And if you click that pin, it will pin this particular document to the top of the list. Now, I know, right now I just have the one document, but imagine 500 documents. This document would remain at the top of the list because I pinned it. So that's a little trick that I think is helpful to know. So in this tutorial, we have gone over all of the basics that you need to know, all of the essentials that you need to know to start using Microsoft Word, whether you're a teacher, whether you're a student, a business person, or you're just using this on your own at home. Microsoft Word is very powerful. You can use it to make all sorts of things. And what I've given you here today is just the basics to help you get started with a few little bonus tips and tricks in there that are a little bit more than basics. So in the future, I'd like to make an advanced Microsoft Word tutorial, so watch for that. But thanks for watching, and please consider connecting with me on my social media websites like Facebook, Twitter, and Pinterest. And definitely do subscribe to my YouTube channel for more videos about technology for teachers and students. And watch for a new video at least every Monday.
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